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Introduction
The AVANT Audiometer series represents a new era of ultra-compact diagnostic audiometry
for your office. Compact yet rugged, this PC-Based system is USB powered and supports
current ANSI and IEC audiometric tests. This manual assumes that the system
hardware, software and drivers are installed and working properly. Please refer to
the MedRx AVANT Audiometer Installation Manual for assistance. The Installation Manual is
included in the original AVANT Audiometer packaging in both printed and PDF formats.
The scope of this manual is to get you “up and running” with your AVANT Audiometer
System. Please consult the interactive Help System within the software for more detailed
information of features and functionality. To access this tool, press the F1 key at any time, or
click the Help icon or text menu with your mouse. Access these by clicking on the “Help” tab
at the top of the screen, and select “Help Topics”. Select an item from the list in the Index tab
and click “Display”.
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The AVANT Audiometer Software Overview
The AVANT Audiometer software can run stand-alone or from NOAH System or the TIMS
NOAH-Compatible Office System.

Launching the AVANT Audiometer Software
Stand Alone

•

Double Click the AVANT
Audiometer shortcut on your
Windows Desktop.

NOAH

•
•

Launch NOAH.
Launch Avant Audiometer module
following NOAH procedures.

Basic Software Options
Several options are available which allow the user to customize the AVANT Audiometer
Software to meet their needs.
Access these options from the File Menu on
the AVANT Audiometer Main Screen as
shown below.
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The Options may also be accessed
from the Audio screen by clicking on
the Options text menu as shown
below.
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The View tab allows you to set the default
appearance of the test environment.

The Audiometry tab sets the look and
behavior of the audiometer.

The MHA/HLS tab sets the default look and
behavior of the Master Hearing Aid and
Hearing Loss Simulator.

If your system has a Tympanometer
connected, this tab will assist in configuring
the look of the display.

NOTE: Remember, more information is always available in the Interactive Help System by
clicking the Help Icon or pressing the F1 key.
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Assign Transducers
Option 1: On the Audiometry Options
screen click Transducers to assign specific
transducers to the audiometer outputs.

Option 2: You can change transducers by
Right-Clicking on any transducer icon on
the Audiometry screen.

The Transducers dialog box will then appear. Select the appropriate transducer for each
output.

To add or remove outputs, Click Outputs to enable or disable transducer buttons on the
Audiometry screen
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Advanced Options
The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot technical issues. Access this
screen from the File Menu on the Avant Main
Screen as shown to the right.
The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the software by pressing the F1 key or clicking the Help icon.

Use the Audio Tab to select the proper audio
The General Tab configures the overall
AVANT Audiometer behavior with respect to device for your Audiometer. This tab also
other Windows programs, specifically NOAH. provides access to the Windows Audio
controls.

If your system has a Video Otoscope, the
Video tab allows you to select the
appropriate device driver.
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If your system has a Tympanometer
connected, use this tab to identify it and
ensure the driver and software that control it
are correctly installed.
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Preparing for Testing
Use the accessories provided with your Avant Audiometer. Typical acceptable transducers are
shown on the “Transducer & Accessories” page in the Installation manual. Operator headsets
for use with the Avant Audiometer should have 32 ohms impedance and the speaker power
should be at least 50 watts. Air conduction transducers for use with this device should have
an impedance of 10 ohms. The speaker voltage should match the local mains voltage where
the device is used.
The Operator Headset with microphone is used by the device operator to communicate with
the patient. The patient talks to the operator using the Talk-Back microphone.

Placing the Earphones on the Patient
Insert Earphones
IMPORTANT: The foam tips used for the insert earphones are for SINGLE PATIENT USE ONLY.
Do not attempt to wash and re-use them.
1. Place a new set of foam tips on the earphone tubes as shown.
These tips are designed for single patient use and should not
be washed and reused.
•

NOTE: When removing foam tips after use, be sure the clear
plastic tubing nipple remains attached to the long
earphone tube.
2.

Carefully compress the tip between
your fingers to allow it to fit into the
patient’s ear canal as shown. Do not
roll the tip between your fingers.

3. Pull up and back on the patient’s
pinna to straighten the ear canal.
4. Place the compressed foam tip deep
within the ear canal.
5.
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When properly placed, the outer
surface of the insert tip will be flush
with the opening of the ear canal as
shown.
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Supra-Aural Headphones
1. Place the headphones on the
patient’s head so the center of the
headphone is directly over the
opening of the ear canal.
2.

Adjust the headband so the
headphones remain in place, but
be careful not to make it so tight as
to cause patient discomfort.

High Frequency Earphones (HDA 200) *Stealth Only*
NOTE: The HDA 200
Earphones are part of an
upgrade option for the
AVANT Stealth Audiometer.
If you need to test
frequencies beyond 8000
Hz, you must notify MedRx.
This option carries a price
differential which will be
detailed at the time of order.

1. Place the earphones on the
patient’s head so the center of the
earphone
is directly over the opening of the
ear canal.
Adjust the headband so the earphones
remain in place, but be careful not to
make it so tight as to cause patient
discomfort.

Placing the Bone Conductor
1. Locate the mastoid process behind the pinna. This is
the bony shelf just behind where the ear meets the
head.
2. Carefully place the bone conductor on the mastoid
process and hold it in place.
3. Place the headband over the head to the opposite
temple.
4. Carefully and slowly loosen your grip to check if the
bone vibrator and headband will stay in place.
If either moves, reposition until both the headband and
bone vibrator are secure.

D-0117967-C 05/2019

9

Sound Field Testing
The Sound Field speakers (Free Field) should be connected using optional or user supplied
amplifier and speakers. They should be calibrated annually as per ISO 8253-2, located at least
1 meter from the patient ear and at the same height.

Device Maintenance
Annual re-calibration of the transducers used with the Avant Audiometer is recommended.
There are no user repairable components of this device. Refer to the Installation Manual for
care and cleaning instructions.

Performing Audiometric Testing
The screen shot below shows the controls which are available from the Audiometer main window.
The sections of the manual that follow explain how to use these tools to perform hearing
evaluations using your Audiometer.

1.
2.
3.
4.
5.
6.
7.

Test selection tool bar
Ear selection
Output selector
Test Type Selector
Tone Type Selectors
Output Level Potentiometers
Masking interrupter and routing selector
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8. No Response button
9. Test Interrupter
10. Back
11. Help
12. Discard
13. Talk Over
14. Legend
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Pure Tone Audiometry
Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest
levels they can hear pure tones at a variety of frequencies. These thresholds are plotted on a
standard graph called an audiogram. The AVANT Audiometer software controls the
hardware, stores the data (if running within NOAH or TIMS) and prints a standard audiogram
report. Pure tone Audiometry can be performed via earphones or a Bone Conductor (Bone
Conduction).
Prerequisites:
•

Before performing audiometry, careful inspection of the ear canal should be
performed. This is best done with Video Otoscopy. After ensuring the ear canal is clear,
place the appropriate transducer on the patient as shown on page 8 & 9.

Pure Tone Audiometry via Earphones
(IP30 Insert Earphones, Eartone 3A Inserts or Supra-Aural Headphones)
1. From the main Audiometer Window, Click the

button on the right side menu bar.

2. By default, the
button will be selected once you enter the main Audiometry
Screen. Other default settings (based on typical clinical practice and procedures) are:
a.
b.
c.
d.

Right Ear
AC (Air Conduction)
Tone Stimulus
Continuous Tone

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that
they should signal (raise their hand, press the patient response button, etc.) as soon as
they hear it. It is helpful to also say “even if it seems very far away”.
4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left ear).
5. Present a tone at 60 dB by pressing the space bar or clicking the

button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up
arrow on your keyboard and present again.
7. Repeat step 6 until the patient signals that they hear the tone.
8. When the patient signals they hear the tone, decrease the level by 10 dB and present the
tone again.
9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times
with the level ascending.
10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5
through 8 to establish the threshold at 2000 Hz.
D-0117967-C 05/2019
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NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or
greater than) the threshold at 1000 Hz, repeat steps 5 through 8 at 1500 Hz
(the “half octave” between 1000 Hz and 2000 Hz).
11. Repeat steps 5 through 8 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz.
12. Repeat steps 5 through 11 in the opposite ear.
NOTE: The software automatically calculates the 3-frequency Pure Tone Average
(PTA) which is displayed above and inside the legend as follows:

Pure Tone Audiometry via the Bone Conductor
1. Following the instructions on page 9, place the Bone Conductor on the mastoid
process behind the ear with better air conduction thresholds as measured above. If
the thresholds are equal, place the Bone Conductor on the mastoid process behind
the right ear.
2. Establish bone conduction thresholds as described above (see page 11, steps 5-8) for
1000 Hz, 2000 Hz, 4000 Hz, 500 Hz and 250 Hz.
3. If the Bone Conduction (BC) threshold at a given frequency is less (better) than the Air
Conduction (AC) threshold by 15 dB or more, you must confirm the threshold by
performing masking.
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Masking for Pure Tone Audiometry
There are several accepted methods for masking. This manual will not promote one over
another, however, to use the masking function on the AVANT Audiometer, follow the steps
below:
1. Click the Masking button. The red light will
appear indicating that the masking is on.
2. Use your mouse to adjust the Masking Level
slider shown on the left to the appropriate
level based on your preferred method of
masking.

3. If you wish to maintain the balance of signal
and masking (for example, masking always
30 dB above the signal), Click the Lock
button after setting the masking and signal
levels.
4. The default for pure tone audiometry is to
deliver narrow band masking to the ear
opposite the test ear. If you wish to use a
different stimulus, or route the masking to
the same or both ears, Click on the arrow to
the right of the Masking On button.
5. Use your mouse to select the new masking
type and routing for your specific
application.
6. When you are finished making changes to
the Masking, Click Close.

D-0117967-C 05/2019
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Optional High Frequency Audiometry
The AVANT Stealth Audiometer is available with the option to perform extended range
high frequency pure tone audiometry. This is used clinically to evaluate noise induced
hearing loss, ototoxicity and tinnitus. High frequency testing uses the same procedure as
described on page 13 for pure tone audiometry.
To start High Frequency audiometry, select a transducer that
supports high frequencies, such as the HDA 300.
The High Frequency control will appear on the right panel and
will allow choosing frequency ranges to be shown on the plot.
The power supply must be connected to activate the high
frequency control or when using the free field amplifier.
NOTE: Extended High Frequency Audiometry is an upgrade option for the AVANT Stealth
Audiometer Only. If the high frequency control selectors do not appear on the right panel and
if you need to test frequencies beyond 8000 Hz, you must notify MedRx. This option carries a
price differential which will be detailed at the time of order.

Speech Audiometry
Speech audiometry evaluates how well the patient can hear and understand speech. The
typical test battery includes tests of speech threshold and tests of speech discrimination.
The sections below detail how to perform these tests on the AVANT Audiometer.

Speech Reception Threshold (SRT)
The Speech Reception Threshold (SRT) is defined as the lowest level at which the patient can
repeat Spondee words with 50% accuracy. Spondee words are two syllable words with equal
vocal emphasis on each syllable such as “baseball” or “hotdog.”
Instruct the patient that they will hear a series of two-syllable words that will get quieter as
the test progresses. They are to repeat the words as best they can, even if they sound very far
away. If they are not sure of a word, they should take a guess.
SRT is typically started 10-20 dB more or less than the patient’s Pure Tone Average, which is
displayed on the lower left of the screen. Set the level of the test signal to 10 dB above the
PTA and follow the steps below.
1. From the Avant Audiometer main
screen, Click the Audiometry
button.
2. Click the SRT button located on the
toolbar on the top of the screen.
D-0117967-C 05/2019
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3. Click the Word List button.
4. Select Spondee Word Lists A&B
from the list.
5. Click Start Test.

6. Click the Play button or press the F9
key to present a word. The word will
play through the chosen transducer
as well as display on the screen.

7. If the patient correctly repeats the
word, click the Correct icon or
press F7.
8. If the patient incorrectly repeats the
word, click the Incorrect icon or
press F8.
Note that the score is calculated and displayed automatically.
If the patient exceeds a 50% score at a given presentation level, stop the test and decrease
the level by 10 dB and repeat the steps above.
If the patient fails to achieve a 50% score after 6 words at a given level, stop the test, raise the
level 5 dB and repeat the steps above.
When the patient scores 50% at a given level, the test is complete. The software
automatically plots the score on the SRT graph.
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Speech MCL & Speech UCL
The patient’s most Comfortable Level and Uncomfortable Level for speech can be obtained
while you are in Work Recognition (WR).
1. From the Avant main screen,
Click the Audiometry button.

2. Click the WR button located on
the toolbar on the top of the screen.

3. Click UCL or MCL.

4. Choose an input option.

5. If you selected File or CD, select the
track you would like to play for the
test in the media player at the
bottom of the screen.
When you have selected your track in the
media player, click play on media player or
hit the spacebar to start.
Adjust levels up or down with keyboard
arrows or by clicking below the dB level at
the bottom of the graph.
6. To Input & Calibrate the Rainbow Passage
in WR for MCL:
a. Press small Green file folder in bottom
left of media player.
b. Select Rainbow Passage by double
clicking twice.
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c. Use the drop down in the media player
and select track 10 – Calibration
(1000Hz).

d. Click play or start signal.

e. On the VU meter at the top of the
screen, press the slider calibration icon
just below and to the left of the VU
meter.
f.

Adjust with mouse or arrow keys so that
the blue bar stops over the black arrow
and there is no red.

g. Click on the channel icon just below
and to the right of the VU to switch
channels.
h. Repeat steps d - f for the remaining
channel.
Note: This calibration also needs to be
done with any custom word list.
7. When using the Mic or live voice option
make sure you press the Start Signal or
space bar to begin.

8. When using the Mic option adjust your
input using the slider so that it is peaking at
the black triangle under the VU meter.
The VU meter is at the top of the MedRx
Software and will become active once you
press Start Signal.
D-0117967-C 05/2019
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Word Recognition (WR)
Word Recognition (WR) is a discrimination, or recognition type test using speech as the
stimulus. WR testing measures the percentage of mono-syllable words repeated correctly
from a phonetically balanced list. Unlike the SRT test, the WR test is performed at a fixed
intensity (dB) level. Typical patients will score their best on WR testing at a level between 35
and 40 dB above their SRT.
Before beginning the test, instruct the patient that they will hear a series of one-syllable
words. They are to repeat the words the best they can. If they are not sure of a word, they
should take a guess.
1. From the Avant main screen, Click
the Audiometry button.
2. Click the WR button located on the
toolbar on the top of the screen.
3. Click the Word List button.
4. Select the desired Word List from
the list. The W-22 or NU-6 lists are
good choices for typical adult
patients. When testing children, the
PBK lists should be used.
5. Click Start Test.
6. Click the Play button or press the F9
key to present a word. The word will
play through the chosen transducer
as well as display on the screen.
7. If the patient correctly repeats the
word, click the Correct icon or
press F7.
8. If the patient incorrectly repeats the
word, click the Incorrect icon or
press F8.
NOTE: that the score is calculated and displayed automatically. The test is complete when all
words in the list have been presented. The software automatically plots the score on the WR
graph.
9. Click the Advance button >> or
press the F10 key to present the
next word. Score accordingly as
described above.
D-0117967-C 05/2019
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QuickSIN (Optional)
The primary complaint of hearing-impaired persons is difficulty hearing in background noise.
The measurement of SNR loss (signal-to-noise ratio loss) is important because speech
understanding in noise cannot be reliably predicted from the pure tone audiogram (Killion &
Niquette, 2000).
The QuickSIN test was developed to:
1.

Provide a one-minute estimate of SNR loss.

2.

Provide a quick way for clinicians to quantify a patient’s ability to hear in noise.

3.

Determine if extended high frequency emphasis improves or degrades understanding
of speech in noise.

4.

Assist professionals in choosing appropriate amplification and other assistive
technologies.

5.

Demonstrate that hearing aids with directional microphones improve speech
intelligibility in noise.

6.

Provide a large number of equivalent test lists for use in clinical and research work.

7.

Provide information useful in counseling patients regarding realistic expectations.

The screenshot below shows the key features of the QuickSIN test.
1. Calibration Button

4. List Selector

2. Ear Selector

5. Track Display

3. Output Selector

6. Track Control
7. Test Type Selector

D-0117967-C 05/2019
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Performing the QuickSIN Test
•

From the Avant main
screen, click the
Audiometry icon.

•

Click the QuickSIN
button on the top of
the Audiometry
screen.

Present the test with earphones or in a sound field. The attenuator dial is set to 70 dB HL. For subjects with
PTA hearing losses greater than 45 dB HL, the attenuator dial is set to a level that is “loud but OK.”, this is
done by the program using the MCL value. A warning legend at the bottom of the window is shown if PTA
is not available. Instruct the patient to repeat the sentences spoken by the target (female) talker. When
testing in a sound field, have the patient hold the talkback microphone close enough so that responses are
clearly audible to the tester.

1. Select a list from the List
Selection Window one of
the following two ways:
•

Click the list, then click Select.

•

Or Double-Click the list number.

2. Play the first sentence in the
list by clicking the Play
button.
Ask the patient to repeat
the sentence.

3. Score the patient’s response
one of the following ways:
• Click the check-box of each
correct key word with your
mouse. This will record the
total number of correct key
words in the score pull-down.
• Record the total number of
correct key words using the
score pull-down or by pushing
1-5 key on the keyboard.
4. Click the next sentence and then
click Play or click >>. This will
advance & play.
D-0117967-C 05/2019
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5. Repeat steps 2-4 until all 6
sentences in the list have been
played and scored.
6.
After all six sentences are
scored, the following
results are displayed:
•
•

Total SNR Loss in dB.
Recommendations.

Tinnometer (Optional)
Purpose of the Tinnometer
Tinnitus is experienced by millions of people worldwide. The Tinnometer is designed to
mimic the sounds of tinnitus in order to provide an accurate and flexible tinnitus assessment.
Tinnitus Assessment increases patient rapport with the clinician when an equivalent tinnitus
sound can be created. The Tinnometer can accurately create tinnitus sounds for fast and
reliable tinnitus assessment. All test results should be used to help counsel the patient on
their specific tinnitus and what the assessment has found.

The Tinnometer test was developed to:
1.

Break away from the traditional limitation of tinnitus assessment with an audiometer

2.

Produce accurate and flexible sounds that mimic patient tinnitus

3.

Provide extended frequency ranges to more accurately match tinnitus sounds

4.

Decrease the time needed to complete a tinnitus assessment

5.

Standardize reporting needed when completing tinnitus assessment

6.

Allow clinicians to save and recall prior tinnitus assessments

7.

Provide general guidelines for implementing results into tinnitus sound therapies
provided by leading hearing aid manufacturers

D-0117967-C 05/2019
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Performing the Tinnometer Testing:
•

Click the Tinnometer button from
the main Avant Audiometer main
screen.

The following screenshot shows the key features of the Tinnometer:
1. Toggle Switch to Start/Stop stimulus
4. Buttons used in determining tinnitus
2. Sliders to control frequency,
match, threshold and minimum
bandwidth, slope and tempo of the
masking level
stimulus
5. Area where description of items will
3. Slider to control the intensity of the
be displayed
6. Channels designed to present
stimulus
multiple types of tinnitus sounds
7. A graphical display of the sounds being played for the patient. Stimulus and
Audiogram (if done within Avant or Noah) are display in dB SPL

Interactions with the patient are controlled as follows:

1. Patient response switch indicator
2. Patient monitor microphone
3. Talk forward
D-0117967-C 05/2019

4. Undo
5. Toggle help section
6. Return to Avant
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There are 3 Steps needed for Tinnitus Assessment with the
Tinnometer
1. Identify patient’s tinnitus by frequency, bandwidth, slope and tempo
2. Lower the identified tinnitus until patient threshold is reached
3. Raise the tinnitus level above the identified tinnitus intensity (widen bandwidth if
needed) until the patient states they no longer hear the tinnitus. Play stimulus for 60
seconds to ensure masking is achieved.
Step 1: Identify Patient’s Tinnitus

3. Use frequency slider to match the
pitch of the patient’s perceived
tinnitus
4. Use volume slider to match patient’s
perceived intensity of tinnitus
5. Adjust bandwidth, slope and tempo
(for pulsating tinnitus or prevention of
adaptation) as needed
D-0117967-C 05/2019

1.

Start by selecting the tinnitus type that
has been described by the patient. This is
an approximation of the tinnitus sound
your patient hears. Tinnitus type will
provide a starting frequency, bandwidth
and slope to help speed up testing time.

2.

Use the stimulus start/stop toggle to
present the selected signal to the patient.

6. Buttons to allow greater flexibility in
bandwidth and slope of tinnitus.
Allows the addition of high/low
frequency sounds independently
7. Allows for independent right/left
volume control
8. Press Tinnitus Level button once the
patient’s tinnitus is matched
23

Step 2: Find Identified Tinnitus Threshold
1. Use down arrow on your keyboard to
lower stimulus until patient states
they are no longer able to hear the
tinnitus.
2. Click Threshold Level button.
Step 3: Masking Tinnitus for 60 Seconds
1. Use volume slider to increase
intensity of the stimulus until the
patient states they are no longer able
to hear their tinnitus.
NOTE: Lower levels of masking may be
achieved by increasing bandwidth of
the masking stimulus. Pulsating the
masking noise can prevent tinnitus
adaptation.
2. Press the MML button and continue
presenting stimulus until 60 second
countdown ends.

Tinnometer Modulation Tab

3. If patient begins to hear their tinnitus
within the 60 seconds, raise intensity
until masking is achieved and repeat
number 2.

The Tinnometer modulation tab is designed to simulate sound generators
when hearing aid demonstrations cannot be performed. The following are
controls used in Modulation.

1.
2.

Type of modulation Sound
Speed of modulation

D-0117967-C 05/2019

3.
4.

Frequency of modulation
Modulation volume range
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To use the Modulation features within Tinnometer, you must first complete
the three steps involved with tinnitus assessment. Once tinnitus assessment
is complete, you can use modulation by:

3.

1.

Activating the channel in
which the tinnitus
assessment was performed.

2.

Enter the modulation tab on
the right side of Tinnometer
software.

Adjust the modulation stimulus with sliders as a counseling tool for the
patient.

D-0117967-C 05/2019
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Tinnometer Audiometry Scan
The Tinnometer Scan tab is designed for various forms of air conduction
audiometry. There are three types of audiometry that can be performed with
Tinnometer. You can access the forms of audiometry with the buttons
located by the number 1 in the image below.

Tinnometer Residual Inhibition (RI)
The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a
patient’s tinnitus. The controls in the RI tab are as follows:
Scale from 0-10 of
tinnitus bothersome
level
2. Timer to begin
stimulus
3. Tracking of patient’s
tinnitus bothersome
level as a function of
time
1.

A complete tinnitus assessment must be performed prior to performing
testing in the RI tab. Once tinnitus assessment testing is completed, optional
residual inhibition testing can be performed with the following steps:
1.

D-0117967-C 05/2019

Activating the channel in
which the tinnitus
assessment was performed.
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5.

2.

Select the RI tab on the
right side of the Tinnometer
software.

3.

Ask the patient the
bothersome level of their
tinnitus from 1 to 10 and
mark their response.

4.

Click the stop watch to
begin the masking stimulus
(stimulus to play for 60
seconds).

Stimulus will play for 60 seconds and automatically stop at the 60 second
point.

D-0117967-C 05/2019
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6.

When the stimulus stops the patient must redefine their tinnitus bothersome
level every 30 seconds. The bothersome level should decrease upon the
stimulus stopping and will increase with time.

7.

The test continues until the bothersome level returns to pre-test level.

Tinnometer Report Printing
The Tinnometer has four reports available for printing: tinnitus assessment
report, manufacturer guidance report, questionnaire report and a channel
report.
The following are common features found across reports:
1. To generate your report,
select “printer …” from
the File menu.

2. Select the paper style
you are printing.

3. Confirm all patient
information is correct.

4. Choose your print
preferences.
5. Change the zoom of your
print preview.
D-0117967-C 05/2019
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6. Print your Report.

Tinnitus Assessment Report
Tinnitus assessment reports are able to be generated after completing the
three steps to tinnitus assessment. Once all steps are complete you are able
to print a report
1. To generate your tinnitus
assessment report, select
“printer …” from the File menu.

D-0117967-C 05/2019

2.

The “Channel” reports are the
tinnitus assessment reports.
Select the channel used for
testing or All Channels when
multi-channel testing is
completed.

3.

Use the drop down box to
select a diagnosis for the
patient.

4.

Comments can be entered in 4
separate lines with a
maximum of 60 characters.

5.

Print the Report.
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Manufacturer Guidance Report
Manufacturer guidance reports are designed to provide hearing aid sound
therapy guidance to a clinician based on tinnitus assessment results. Sound
therapy is an option to tinnitus treatment. We encourage all clinics to
develop a tinnitus treatment protocol that is in line with their tinnitus
treatment goals. Manufacturer guidance generated by the Tinnometer is
designed to be a starting point in sound therapy and each patient may differ
in preferred sound.
Manufacturer guidance reports are able to be generated after completing the
three steps to tinnitus assessment. Once all three tinnitus assessment steps
are complete you are able to print a report.
1. Select the manufacturer that
you would like to have printed
in your report.

2. To generate your tinnitus
assessment report, select
“printer …” from the File
menu.

3. Select “Hearing Aid Guidance”
from the list of reports.

4. Use the drop down box to
select a diagnosis for the
patient.
5. Comments can be entered in 4
separate lines with a
maximum of 60 characters.
6. Print the report.
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Graph Channel Report
Graph channel reports will print a patient report which displays an image of
the patient’s tinnitus with QR codes for YouTube videos that play a wind
modulation noise nearest to their tinnitus. To generate the report you must:
1. To generate your tinnitus
assessment report, select
“printer …” from the File
menu.

2. Select “Graph Channel” from
the list of reports. Select the
channel number which you
used to match your patient’s
tinnitus sound.

3. Print the report.

Questionnaire Report
Questionnaire reports will only show as an option once the questionnaire has
been completed. Once a questionnaire has been completed and you are
ready to print a report you must:
1. To generate your tinnitus
assessment report, select
“printer …” from the File menu.
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2. Select the name of the
questionnaire you want to
print from the list of reports.

3. Print the report.

Hearing Loss Simulator
The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the
significant third party. The program attenuates an input signal to simulate the audiogram.
The third party listens to the free field speakers. The third party can hear how their own
voice is distorted by the hearing loss when the Record input option is used.
The Hearing Loss Simulator requires the client’s Audiogram data. This data can be manually
entered in the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task
1. Select the Hearing Loss Simulator tab on the toolbar.
2. Enter the Audiogram values manually if the data is not automatically imported to this
screen.
3. Select the input signal type: Mic, File or Record. Select the track and the Play button on
the control panel. See below for instructions on how to use the Record option.
The HLS output is directed to the free field loudspeakers.
4. Select Normal to play the input signal as a person with normal hearing would perceive it.
Select Simulated to turn on the simulation of the client's hearing loss. Toggle between
these selections as necessary.
5. The Reset option restores the audiogram to the original state. Use this option if you have
modified the audiogram while in the simulate mode but want to undo the changes. The
changes to the Audiogram that are made on the HLS screen are temporary and will not
affect the client's original audiometry record.
6. A volume control adjustment bar allows modifying the audio for manual adjustment of
the output level of the free field speakers. This allows the practitioner to demonstrate
improvements to hearing loss with amplification or what happens when further hearing
loss occurs.
7. To stop the playback, select the Stop button on the player.
Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing
loss.
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Record Input Option
This option allows recording and play back of the voice of the third party.
Note: The LSM option appears on the bottom half of the display. This is so the unaided and
aided results can be displayed simultaneously for the patient and significant third party.

Master Hearing Aid
Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits
of amplification to an inexperienced user. The system applies the fitting rules by default to
the patient's audiogram and simulates a hearing aid. The patient listens to this signal through
the headphones. Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display
The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and
Frequency in Hz on the horizontal axis. The plot on the graph represents the gain applied to
the patient’s Audiogram. The NAL-RP is applied by default. A new rule can be selected from
the list on the right side of the display. A volume adjustment bar allows for manual
adjustment of the output level. The control panel on the right of the display provides options
for input signal source and the task icons for Normal and Simulate.
The Master Hearing Aid applies gain separately for each ear. If audiogram values are
entered for the left and right ear, the selected fitting rules will be applied to each ear
separately. Different rules may be entered for different ears (i.e. NAL-RP for left ear and
BERGER for right ear). If an audiogram is entered only for one ear, the gain will not be adjusted
for the opposite ear and the sound for that ear will be normal.
If Binaural mode is selected, the sound will be heard from both channels (left and right). If
Monaural mode is selected, the sound will be heard only from the channel corresponding to
the active ear when the channel for the opposite ear will be muted.

Input signal
Live voice (microphone) allows you to use the right probe mic for live speech input to the
headphones. The clinician or significant third party can speak into the microphone for this
activity. Note: there is a processing delay between the input and playback. Make sure that the
client cannot hear the voice directly but only through the headset. If this is not possible, use
the Recorder (describer below) to simulate speech input.
File allows the user to play sound files. The program supports MP3 and WAV files and comes
with a
preset MedRx Sounds Sensations set of files. After the option is activated, use the player panel
to control the playback.
CD allows the user to play music CDs. After the option is activated, use the player panel to
control the playback.
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Record input mode allows the clinician or third party to record a sample of their speech
which can then be replayed for repeat comparisons under different amplification conditions
for the patient. Refer to the interactive Help system by pressing F1 or clicking the Help icon
to learn more about the recorder.

How to use the Master Hearing Aid:
1. Select the Master Hearing Aid (MHA) icon from the main screen.
2. Enter the Audiogram values manually if the data is not automatically imported to this
screen.
3. Select the input signal type: File, CD, Mic, or Record.
4. Select Monaural or Binaural.
5. Select the Normal icon which will send the input signal through to the inserts without
modification. The patient is listening to the signal without any amplification benefit.
Select the Simulate icon to modify the input signal according to the selected rule. This
selection allows the patient to hear the benefits of amplification. Toggle between these
two selections as necessary.
6. If the simulated frequency response needs to be adjusted, based on feedback from the
patient, manually edit the response by clicking on the gain curve at the desired frequency
and new gain level. The gain curve of the selected test ear on the control panel can be
edited. To edit the other ear, click the appropriate test ear icon on the control panel first.
Hint: Use the track return icon on the player control panel to
replay one track continuously.
The Reset option restores the rule to the original state. Use this
option if you have modified the rule but want to undo the changes.
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Printing
Printing within the Avant Audiometer software is very simple.
From the File menu, click one of the following options:
Page Setup – Allows you to set margin sizes and the
default text header for your reports.
Print Setup – selects the printer you want the report
to be sent to.
Print Preview – Shows you what your report will look
like before you print it.
Print – Sends the report to the printer. This option
opens the Windows Print dialog which allows the user
to select any installed printer and modify the
properties (quality, number of copies, etc.) for the
print job.
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Symbols that may be used:
Read the instruction manuals
for safe usage of the device
(operating instructions)

or SN Indicates that the device
serial number will follow.

Read the instruction manuals
for safe usage of the device
(operating instructions)

Temperature limitation

Type B applied part.
(Type B equipment)

Class II equipment

Manufacturer (MedRx)

Microphone

Start (of action)

Start (of action)

Stop (of action)

Non-ionizing
electromagnetic radiation

Authorized Representative
in Europe

Special Disposal Required

Percentile Setup

Humidity Limitation

Calibration

Loudspeaker (Speaker)

Caution, General warning sign

Headphones

Handheld microphone
(Talkback Microphone)

Recording

CAUTION
For Single Patient Use Only
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Limited Warranty
MedRx, Inc warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to
perform as specified during this period, the purchaser is responsible for
calling MedRx at (888) 392-1234 or (727) 584-9600. The company's
representative will advise the owner to either return specific components
or the entire system to:
MedRx, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA
MedRx will repair or replace any defective devices, fully test the system
and/or components and ship the system promptly back to the owner.
There is no cost for the repair or return shipping, provided the system is
one year old or less and has not been misused, abused or damaged. Such
damage includes, but is not limited to, dropping, exposure to excessive
heat greater than 100ºF and water/liquid damage.
Repair or replacement of the system as provided under this warranty is the
sole and exclusive remedy of the purchaser. MedRx shall not be liable for
any consequential or incidental damages or for breach of any express or
implied warranty. Except to the extent of applicable law, any implied warranty, merchantability or fitness of this product is limited to the duration of
this warranty.
MedRx will, at its discretion, service and repair out of warranty products at
the purchaser's request, charging for parts and labor as necessary.
The limited warranty is deemed void if software or hardware is installed on
this product which is not pre-approved by MedRx, Inc. Approved software
includes NOAH™ and HIMSA approved hearing aid manufacturer
programming modules for fitting hearing aids.
MedRx, Inc is not responsible for problems resulting from installation of
unapproved software or hardware. In the event of unapproved software or
hardware installed on the system causing a conflict, MedRx will service the
product for a fee to be determined at the time of service.
Any extension of this warranty past the initial one-year warranty is subject
to the following (where applicable).
1. A $300 deductible per repair.
2. Extended warranty does not include cables, connectors or peripherals.
3. Extended warranty of the Video Otoscope covers optics only.
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